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INTRODUCTION 
I played in a band during my high school and college years, and like every other 
boy who played in a band, I too had a dream of recording my songs and signing 
a deal with a major record label. Our interest was the reason we aspired to play 
music, but there was also the "hope of fame and fortune" in the music industry 
that kept us spending years in a wild goose chase. 

While some musicians do find their lucky break, many others have to learn the 
hard way that the path they've taken is no ride in the park. While dealing with 
an unpredictable future, most musicians have to go through a time-consuming, 
difficult, and (extremely) expensive song recording process. 

As a (self-proclaimed) musician, I have to admit that I envy the younger 
generation of musicians for everything that they have today. Even though luck 
still plays a major part, recording and marketing songs have become much 
easier, so that any newbie could do it. 

All you need is a computer with an internet connection. Mac OS X, the Apple 
operating system, has Garageband – definitely the simplest way for common 
people to produce their own songs. 

1. GarageBand: A simple yet powerful recording studio 

To put it in simple terms, GarageBand (http://www.apple.com/ilife/garageband/) 
is the tool that will allow everyday computer users to create their own songs, 
quick and simple. It's a part of the iLife suite – priced at $79, but is installed by 
default on newly purchased Macs. 

Not all Mac users need Garageband; some will delete it completely, some will 
leave it be, some will meddle with it a little to create ringtones for their 
cellphones (http://www.makeuseof.com/tag/how-to-create-your-own-unique-
iphone-ringtones-using-garageband-mac-only/) or maybe try making a podcast 
or two (http://www.makeuseof.com/tag/how-to-create-broadcast-a-podcast-
with-garageband/). However, for musicians (or those who wish to be), 
Garageband is a complete recording studio with more musical instruments than 
you'll ever need. 

To many music lovers and creators, this application is a dream come true. One 
single person could create a good quality 'demo tape' of his or her songs in no 
time. 

This humble eBook, freely distributed by MakeUseOf.com, is not intended to be 
a full-blown course on Garageband. We will probably just scratch the surface 
here and there, and help you on your way. 

As wise men say, the first step always is the most important one. Right? 
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2. Today's Music Industry and Independent Musicians 

In my personal opinion, the music industry is on the verge of a major change. 
The internet and digitalization of multimedia have given music artists more 
independence, while the record labels are losing their grip little by little each 
day. 

The story of Radiohead and Rainbow has become some kind of legend in the 
music industry, and more big names are following this same path – breaking off 
from oppressive record labels, and releasing their music independently via the 
internet. 

But what does this mean to the rest of us? Just like YouTube, this newfound 
playground will allow anybody - professional musician or not - to make their 
own music available to the world. 

Whether you want to embrace the opportunity is totally up to you. But if you do, 
I hope this book will help, even just a little. 
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A. Investing in instruments and hardware 
A good recording depends all too much on the instruments themselves. Even 
though today's digital recording technology allows us to do the unthinkable 
sound manipulations, it couldn't produce Josh Groban's voice out of mine. 

If your guitar is so bad that it can never be properly tuned, or if your voice is 
recorded so badly that nobody can figure out what it is that you are saying; the 
digital touchup won’t be able to do much to fix the results. 

That's why I suggest you invest in good musical and recording instruments. 
Nothing too fancy (like the professional mixer they use in professional recording 
studio), but just enough for us to produce 'listen-able' songs. 

We've already got Garageband and a Mac computer, that's a start. Other things 
that will make our little project go more smoothly are a good microphone(s), 
good musical instruments, and maybe an external USB pre-amp. 

 

I'm no expert in these fields, so I won’t tell you what to buy. What you could do 
is find recommendations on the internet. A good place to start is Amazon.com. 
There are hordes of everyday people reviewing the products that they've used 
themselves. 

B. Learning to play - Guitar and Piano 
While it's not necessary for you to be able to play a musical instrument in order 
to record songs in Garageband, the ability will make the whole process a whole 
lot easier. I learned to play classical guitar in my early junior high years, and 
those long lost skills of plucking the strings and reading the 'gibberish' notes 
really come in handy during my Garageband projects. 

There's no such thing as 'too old to start learning'. If you'd like to learn to play 
guitar and/or piano, Garageband 09 comes with some basic tutorials.  
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There's the "Learn To Play" menu on the left pane of the Garageband start 
menu. You'll find 9 basic Piano lessons and another 9 for Guitar.  

 

 

There's also the "Lesson Store" where you can buy lessons from well-known 
musicians, explaining how you play their famous songs. 

Please note that (due to legal restrictions), these lessons are not available in all 
countries. 

C. The concept of the song 
There are people who go out and build their houses, just like that. There are 
others who plan their houses before they do the building.  
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The same thing is true for everything else in life, creating music included. There 
are the doers and there are the planners. Both are fine and there's no wrong or 
right. I consider myself as both, but I personally think that the bigger the stakes 
are, the better the plan we must have. 

In theory, you could just open Garageband and start recording. But to get 
better results, you should at least know what kind of song you want to produce. 

Better yet, get your guitar (or piano, or other musical instruments that you 
know), then play along while scribbling the song. Garageband can kick in 
anytime you are ready. 

It would be best if you have the song ready before starting with Garageband. 

1. The lyrics and the music 

One of my favorite quotes comes from the movie Music and Lyrics, "If music is 
the physical appearance of a person, the lyric is the personality." People could 
get attracted to the music, but the lyrics are what listeners fall in love with. 

 

Whether this statement is true or not (as some music do fine without lyrics and 
some lyrics also stand strong without music), I think that we should agree that 
both elements contribute to the overall quality of the song. 
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Asking which one should go first is like asking the chicken and egg question. 
You should do it in the way that you are comfortable with. You can do it either 
way around, or you could even do the music and lyrics simultaneously. 

And nobody said that you have to stick to one method for all eternity. 

2. Learning from popular songs 

One amazing quality of children that most adults should reacquire is the 
willingness to learn by imitating others - without ever giving until they are able 
to do it. Without this ability, no human in this world would be able to walk or 
speak. 

While I'm not endorsing you to copy other people's works (that's plagiarism), I 
strongly advise you to start your Garageband project by doing the cover of 
popular songs that you like. (Or at least start to really pay attention to the 
details of those songs.) 

There are reasons why those songs become popular. You could learn a lot from 
doing the cover, from the overall composition of the songs; to more technical 
things like the volume settings, the timing of the drum break, the best location 
for background vocals, etc. 

Then, using this (newfound) knowledge, you are again a little more prepared to 
start recording your own song. 

Now, let's get our hands dirty. 
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A. Getting started with GarageBand 
Compared to other music creating software, Garageband is very easy to use. 
Still, it is not a simple application that can be mastered in one go. There are 
many elements that make this application such a remarkable piece of software. 

Let’s take on our project one little step at a time, starting with getting familiar 
with the interface. 

1. The Song 

As I've said at the beginning, it's a bit hard to start Garageband with a blank 
state of mind. We need to at least have an idea of what song we are going to 
make. 

Just to give you a clearer picture, this is an image of my song preparation.  

I was sitting with my guitar, desperately looking for a song idea to use for this 
eBook. I was considering using one of my old songs, but suddenly Mr. Muse 
decided to pay me a visit. 

I got the idea for the song from a C9 chord I played on my guitar. The appergio 
turned into a hum, then phrases started to appear. I quickly scribbled down the 
lyrics in TextEdit, while trying to figure out what kind of song this would be. 

Then I decided that this would be a slow-tempo song about a boy who fell in 
love with a girl he saw walking along the street everyday, but he didn't have the 
nerve to tell her about his feelings. That’s where the title: "Unwritten, 
Unspoken" came from. 

Cheesy, I know.  But bear with me. 

2. Opening a project 

Open Garageband and choose "New Project" 

There are many project types that you can choose. Each comes with a different 
combination of instrument. I advise choosing "Songwriting" as this type comes 
with a complete combination of basic instruments. 

 

http://www.supersubconscious.com/�
http://www.makeuseof.com/�


Recording Your Next Hit with GarageBand 

 

 

                                                                      supersubconscious.com  | 13 

 

The next step is to save the project and decide on a few basic details: give a 
name to your project (just use the song title if you've already thought of one), 
choose the location to save, and set the song tempo, signature, and key. 

 

Basically, the tempo tells how fast your song is, the signature decides the beat, 
and the key sets how high/low the song should be sung. 

It would be great if you could set the numbers at the very beginning, but if 
dumbfounded, you could just leave it be as these settings can be adjusted later. 

Click "OK" to move on to the next step. 
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3. Adding and removing tracks 

From the "Songwriting" project, you'll have several preset tracks: Voice, 
Acoustic, Piano, Muted Bass and Drums. The names are editable. You could 
easily change "Piano" into "Leading Melody" by clicking on the name once and 
retyping it. 

 

You can easily remove tracks that you don't need by pressing Command + 
Delete, and add new tracks by pressing Command + Option + N. It's also 
possible to duplicate an existing track by pressing Command + D.  

All of these commands are also accessible via the "Track" menu. 

 

Opening a loop with the loop browser will also create a new track, but more on 
this later. 
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For my song, I added Electric Guitar, Electric Bass, Synthesizer, and one more 
drum kit track. I also deleted the Piano and Muted Bass tracks. 

4. Track controls and effects 

GarageBand gives its users the ability to add virtually as many tracks as they 
need, but it's possible to have too many tracks, making it very difficult to 
monitor anything anymore. 

That's why there are track controls. They are located under the track name. 
There are:  

- Record - To start recording the plugged in instrument in the track. 

- Mute/Unmute - To mute/unmute the track  

- Solo/Unsolo - To mute/unmute the other tracks.  

- Lock/Unlock - To make the track (un)editable. This will free up some 
processing power of your Mac as well, and is very useful if your machine runs 
out of juice. 

- View/Hide Automation - To show/hide the automation pane. Using automation, 
you can set different volume and pan control in a specific location of the song, 
but only for the selected track. 

If you are unsure which button is which, just hover your mouse over the button. 

 

You could also play with the sound of each instrument by editing the effects 
within the Track Info pane on the right. 
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5. Playing with regions 

Within a track, there are regions. These are the places where the notes from a 
specific instrument reside.  

 

To get a view of the regions, you may have to click the "View/Hide Track Editor" 
icon from the bottom left of the window. 

 

There are some manipulations that you can do to the track's region. You can: 

1. Split → move the marker into position and press Command + T or use Edit → 
Split menu. 

2. Move → just drag and drop the region to the desired position. 

3. Copy → drag and drop the region while holding the Option key. 
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Please note that to select and move/copy a region within an already selected 
region, you have to select another track first and go back to select the region 
that you want to move/copy. 

You can also select multiple regions using Shift or Command key. 

6. Manipulating the view 

Sometimes you need a more detailed view to better edit the track, and Track 
Editor's view is not enough. Other times, you’ll need to see the song as a whole. 

This is when you need GarageBand's zoom level feature. It's located under the 
Tracks pane or Track Editor pane. Slide the marker to the left to zoom out or to 
the right to zoom in. 
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7. Adjusting pitch and tempo 

As I mentioned earlier, the basic settings of the song - configured when you 
created a new project - might not be right. You can adjust them by choosing 
"Project" from LCD modes at the middle part of the bottom window bar. 

 

Then you can click on any element of the song - key, tempo, or signature - to 
change it. 

 

Being a slow ballad, I changed my song tempo to 90 bpm (beat per minute), 
and left the rest untouched - for now. 

8. Going around the song 

There will be times when you would want to go straight to a certain part of the 
song. You could do it easily by moving the song marker to the desired position. 

But you could also use keyboard shortcuts to speed up the process. Here are 
some of them: 

⁃ Start/Pause the song  - Spacebar 

⁃ Move one beat left/right - Left/Right arrow 
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⁃ Move up/down tracks - Up/Down arrow 

⁃ Back to the beginning of the song - Return/Enter 

You could also play the song over and over a certain segment of the song. To do 
this, you have to click on the "Cycle Region" button next to the play button. 

 

A yellow bar will appear at the top of the window indicating the area where the 
song will be cycled. You can move the bar by dragging it, or extend/reduce the 
area by adjusting the edge. 

 

This feature will be very useful in recording live instruments. 

B. Software vs. Real Instruments 
In Garageband, you have the choice to use Software Instruments, or Real 
Instruments. Each comes with its own advantages and disadvantages. Before 
deciding which one to choose, let's look at them a little bit closer. 

1. Software Instruments 

In its most basic sense, software instruments are actually sets of instructions 
that will tell the computer how to produce a specific kind of sound. That's why 
they can be set to produce any kind of sound, and are also highly editable. 

The problem is, they also consume a considerably higher amount of processing 
power of your machine. The more instruments that you use, the heavier the 
burden for your Mac.  
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But there's a way around this limitation. You can lock some of the tracks by 
clicking on the lock icon. The tracks will be rendered to your hard drive as fixed 
sound files and can (temporarily) not be edited, thus freeing up some 
processing power previously required to translate the complex digital 
instructions into music. 

 

GarageBand uses green as the color of software instruments. 

 

2. Real Instruments 

As the opposite to software Instruments, real instruments are basically musical 
samples that were recorded from - well - real instruments. You don't have to 
worry about the quality of the sound and they require less processing power 
than the software instruments.  

The disadvantage is that they are not as easy to edit as their counterparts. 
GarageBand newbies might find themselves limiting their creativity to their 
instruments, and not the other way around, as it should be. 

GarageBand assigns blue to the real instruments. 

 

3. Which one should you use? 

This should not be a difficult question. Even though you can build complete 
songs using only software (or real) instruments, most people stand somewhere 
between these two extremes. 
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If you plan to use the loops without any modification - again, this is another 
extreme - you should just find the sounds that you like. 

C. Using the loops 
One of the biggest features of GarageBand is the ability to use loops to quickly 
build a song. There are already hundreds of loops that come with GarageBand, 
you could get more by purchasing Apple's Jam Packs or other commercial loops 
available out there. There are also free loops scattered around the net, just a 
search engine away. 

1. Using ready-made loops 

To use loops, open the loop browser by clicking on the eye icon located at the 
bottom right of the window. 

 

The Loop pane will be opened on the right side of the screen. You can filter in 
the items that you need by pressing the corresponding buttons. The filtering 
categories are by Genre, Instrument and Mood. Click the orange "Reset" button 
to start over. 
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For example I wanted to find drum loops with a rock flavor for my ballad song, I 
pressed "All Drums" then "Rock/Blues" continued with "Relaxed" and the choices 
will appear at the lower part of the loop pane. 

 

Click on one of the results to listen to it, navigate through the results using the 
up and down arrow keys or your mouse. Click and drag the loop to the main 
window to use it. You could put the loop into one of the existing tracks. But if 
the loop does not match the track or if you drag it to the empty area of the 
main window, a new track will automatically be created for you. 

 

2. Creating your own loops 

If you edited and combined some pre-made loops, or if you recorded your own 
tracks (which will be discussed in the next chapter), and wanted the result to be 
available for future projects; you can turn them into new independent loops. 
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Just select the part of the track that you want to convert, and choose Edit > Add 
to Loop Library menu. 

 

D. Recording Your Own Track 
If you are serious about creating your own original music, you would prefer to 
record your own creation instead of using loops. Surely, taking this path will be 
more difficult than using ready-made loops, but the result would be worth the 
trouble. 

Similar to loops, you could record your original notes using both Software 
Instruments or Real Instruments and then combine them to build the complete 
song. 

1. Software Instrument 

There are several ways to "record" your own Software Instrument: using 
GarageBand's Piano Roll, writing down the musical score, playing the notes with 
musical typing, clicking the notes on the virtual keyboard, and using an external 
MIDI instrument. 

Whichever way you choose, you can start the recording process by selecting a 
software instrument track (or create a new one) and click the record button at 
the bottom bar. To stop the recording process, click the record button one more 
time or hit the space button on your computer keyboard. 
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But before you do that, you have to prepare your input method.  

If you choose the Piano Roll, open it by clicking the track editor at the bottom 
left of the GarageBand window and choose the Piano Roll tab. There are several 
adjustable elements that you can access from this view. 

 

As the recording goes, you click on the piano key to determine the note, and 
hold the key for as long as you want the note to sound. 

This method of recording is highly uncomfortable. Try it for yourself and you will 
know why. 

But worry not, because you can easily edit the recording result. Click and drag 
each note to the pitch (position) that it should be, and click and adjust the 
length of each note to the shape that you originally intended. 
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For those who are musically literate, the more comfortable way of editing the 
notes is by switching to score view. You can edit all the notes the same way you 
do in the Piano Roll view, but with less clutter. 

 

Another fun way to input the notes is by using the virtual Keyboard              
(via Window > Keyboard menu or Command + K)  

 

And of course Musical Typing (via Window > Musical Typing or Command + 
Shift + K) 

 

Everything will be so much easier if you have an external MIDI instrument - 
something like a USB-compatible musical keyboard. Just plug the keyboard and 
GarageBand will automatically detect the instrument. 
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2. Real instrument 

I think that recording real instruments is as straightforward as the name 
suggests. Basically, you can record any kind of external sound source into 
GarageBand like a guitar, piano, drums, or your own vocals. 

The first step is to create a new track and choose Real Instrument from the 
option. If you want to record an electric guitar, choose the "Electric Guitar" 
option instead. This option comes with guitar amps and effects. 

 

Then you can customize the track to fit your needs. For example, if this track is 
used to record your voice, choose "Vocals" from the options and choose the 
effect that you prefer. 

 

http://www.supersubconscious.com/�
http://www.makeuseof.com/�


Recording Your Next Hit with GarageBand 

 

 

                                                                      supersubconscious.com  | 28 

You can also determine what "Input Source" that you want to use. Most Mac 
machines come with a built in mic, but I suggest you use a proper external 
microphone to get better results. 

 

After tinkering with all the settings, don't forget to save it by clicking "Save 
Instrument". 

To begin the recording session, hit the record button. 

TIPS: You can do a multitake recording within a track. This method will allow 
you to get the best results from the recording sessions. 

To do multitake recording, activate the cycle region and set it to the part of the 
song that you want to record (Look at chapter 2.A.8). Hit the record button and 
the process will loop around that region. You can play as many times as you 
need. 

Then you can listen to each take and choose which one is the best. Better yet, 
split the track and choose the best parts of each segment and delete the rest. 
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E. Arranging and Mixing 
Now comes the most important (and difficult) step in recording a song, but yet 
the most forgotten step by most amateur musicians: the arranging and mixing. 

Again, taking an example from the process of building a house, this step is 
comparable to the finishing touches of a house. You might have a solid building 
there, but without a proper finish, the house wouldn't look nice and comfortable 
to life in. 

The arranging and mixing is no simple process. To master it, you need a good 
sense of music and years of practice. So do not expect David Foster quality at 
your first sessions. He and other experienced producers and arrangers are years 
ahead of amateurs like us. Still, by doing this final touch, you'll have much 
better results compared to the untouched raw recording. 

As I am no expert in this field, I am not in the right position to give you any 
advice whatsoever. But what I can tell you is you'll get better at this if you keep 
experimenting to find the right settings for you.  And, always ask for second - 
third - forth - fifth - and so on - opinions from people around you. 

1. Basic song arrangement 

The first step of arranging your song should be tagging parts of your song with 
proper section name like "Introduction", "Verse 1", "Reff", "Coda", etc. Later on, 
you can easily move, copy or delete these parts of the song according to your 
needs. 

But before you can do that, you have to make the Arrange Track bar appears. 
Go to Track > Show Arrange Track menu (Command + Shift + A). 
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Then you can click the "Plus" button (+) to add segments to the song. You can 
adjust these segments by clicking and dragging them, and you can rename 
them according to their role. 

 

2. Adjusting Volume and Pan 

Have you ever noticed that each element of a well recorded song has various 
volume settings throughout the song? For example, the guitar volume which is 
dominant at the beginning of the song is adjusted down after the singer’s voice 
kicks in and later on turned up again when the guitar plays the lead melody in 
the middle of the song. 

Those elements also have their own unique "position" (and sometimes the 
position changes). For example, the lead vocal is in the middle, the rhythm 
guitars are a little bit to the left, while piano is on the other side. On 
GarageBand, this setting is called Pan. 

This "simple" volume and pan control alone will increase the quality of your song 
recording dramatically. 

To set volume control and pan of a track, click the small triangle on the track 
control. A new bar will slide open under the track. Choose "Track Volume" from 
the choices and you can set the volume of the track in any part of the song by 
clicking the indicator line on the right to create a point and then drag the point 
to the position and level that you desire. 
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You can do similar things with Pan Control. Choose "Track Pan" and set the 
position the same way you do with volume control. You can even alternate the 
position of the instrument from left to right and back throughout the song. 

 

3. Editing effects 

GarageBand also gives options to add and edit effects to each individual track. 
Choose "Add Automation" from under the Volume and Pan option. 

 

Then choose which effects/controls that you want to add to the track by 
checking their boxes. Click OK when you're done. 
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Your choices will appear as new options the Volume and Pan. Choose one and 
adjust it the same way that you do with Volume and Pan. 

 

The combination of effects and adjustments that you can get are virtually 
limitless. So again: experiment, experiment, experiment. 

F. Exporting the song 
Now, it’s cooking time. After you mix and process all the ingredients into a 
single piece of dough, you need to bake it to produce the bread. This step will 
create your final product, either as digital music files that you can keep (or sell) 
or as an audio CD that you can play in your CD player. Compared to the other 
steps, this one will be a short breeze. 

Go to the "Share" menu and you will find "Send Song to iTunes" and "Burn Song 
to CD". Choose the one that you prefer. 

 

If you choose iTunes, you'll get a bunch of fields to fill out, such as Artist and 
Album's name, also compressing options and audio settings. 
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GarageBand will choose AAC as the default compression format, but you can 
change it into MP3. 

And if you choose to burn the song into an audio CD, all you need to do is insert 
a blank CD and click "Burn". 
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G. The forgotten: Album Art and more 

If you truly want to make a professional quality song, you should not forget to 
create and include Album Art image(s) to your songs. 

I would say that it's OK to throw in a mediocre quality of image for your songs, 
but that would be lying. As the image is the first thing that people see, you 
MUST have good quality album art. Go to the nearest music stores (or browse 
to the iTunes Music Store and Amazon) to get ideas on what other people do for 
their album art. 

 

Go and hire somebody with graphical artistry if you have to. But make it good. 
Cover Art could make or break the deal. People DO judge a music album by its 
cover. 

Of course, the story would be totally different if you plan to make your songs 
available only to yourself. 
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A. Three Alternatives 
The next important step to establish yourself as a musician is to publish your 
songs. In this chapter I will describe three alternative methods that you can use 
to independently do just that via the internet. 

Of course you can always use the traditional way of going through the major 
labels, but the path is harder to travel. Besides, you will have more creative 
independence (and wider market) by going indie. 

Here goes. 

1. Zero-cost start 

Although it seems impossible, you can start marketing your songs through 
major digital music retailers (iTunes, Amazon, etc.) with zero dollars. It means 
that the typical hungry musician can see their name amongst the big names 
without having to pay anything - upfront. 

Is that wonderful news or what? 

There's a service called RouteNote (http://routenote.com/) which gives anybody 
the equal chance to release their music to the world for free. However, they will 
keep about 10 percent of the profit as their fee. 

I personally think that this is a good deal. Especially for those who have no 
extra cents to spare. 
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2. Full profit 

If you feel that you should retail all the profit from your creative endeavour, you 
could use the second scenario instead. The service, called TuneCore, 
(http://www.tunecore.com/) will let you keep 100% of all the profit from your 
sales. However, they charge "Worldwide Digital Distribution" cost: US$ 9.99 for 
a single and US$ 46.99 for an album. 

This scheme might not be for everyone, but if you already have a huge fanbase, 
you'll get bigger profits this way. 

 

3. Non profit 

And here's another possible plot. If you just want your music to be heard, trying 
to establish a name for yourself without thinking about the financial 
compensation, you may distribute your song for free. 

There are tons of ways to do this, starting from creating a Facebook fan page 
(http://www.makeuseof.com/tag/how-to-promote-your-blog-using-facebook-
pages/), using one of the many independent online music communities 
(http://www.makeuseof.com/tag/top-indie-music-websites-100-legal-drm-free-
downloads/), to building your own blog (http://www.makeuseof.com/tag/how-
to-build-a-self-hosted-wordpress-blog-for-free/) and putting the download link 
there. 

I personally think that everybody should get some reward for their hard work. 
And if you think you've done quite a job to be able to release your music to the 
world, you should consider yourself worthy enough to earn that reward. 
However, not everybody considers money as the only reward. So, you've got to 
walk your walk. 
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B. The Promotion 
One of the most important lessons I learn in life is that, "The quality of the 
promotion is as important as (if not more than) the product itself.” No matter 
how good you are, if nobody knows about you then everything that you have to 
offer is useless. On the other hand, even if you are only mediocre, if everybody 
knows you then you can be very popular. 

The same thing goes for your song. If you only keep it inside your hard drive, 
nobody will know how beautiful it is. So the magic words will be: promotion, 
promotion, promotion. 

1. Friends and family 

Start with your friends and family around you. Spread the word that you've just 
released your songs to the world. Give them the iTunes/Amazon links to your 
songs/album. Even if your materials are still "rough diamonds", your parents 
will proudly tell their bingo buddies about their child's musical career. 

And if you do have that musical knack, word will spread by itself. 

2. Social networks 

The most common internet route for independent musician is MySpace 
(although I've been told that it's not as powerful as it used to be). But there are 
tons of social networking sites out there, and by all means, use them. 
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3. The world 

If we were already in the space era like the Star Trek universe, I would say to 
you to spread the words to the whole universe. But as the blue planet is still our 
limit for today, I can only say "Spread word to the whole wide world". 

Use the internet; join forums, write articles, leave comments on related blogs, 
start Google AdWords campaigns if you have to. Let everybody knows and you'll 
have your career as a world musician. 

4. The economy of worldwide indie musicians 

The question is whether or not all these efforts are worth the time and energy? 
If you truly want to make a living as a musician, you'll have to relate the answer 
to money, right? 

Start by defining how much money you need to earn every month before you 
can call it making a living, then determine how many songs you need to sell to 
reach that target. If you think the target is too difficult to reach with only one 
song title, increase the quantity of your songs. 

I'm no economist either, but let's do a rough calculation. If you can get 1000 
people to buy one of your song at 90 cents, you would cash in US$900. Can you 
reach this target every month? 

What if you have two songs? Then you only need to sell half of that amount per 
song title. 

And so the calculation goes. 

After reading "The Long Tail" by Chris Anderson, I can conclude that even the 
weirdest genres have their own market. So, don't lose hope. 

 

C. Shameless self promotion 
Just like any other musicians, I also want my songs to be heard. I've written 
many songs (including the one that I use in this ebook: "Unwritten, Unspoken"), 
but most of them are still in the form of handwritten (yes, this is true) lyrics and 
chords. 

My encounter with GarageBand has sparked a new flame inside me. I wanted to 
breathe life into my songs - something that I haven't been able to do in my old 
days - and release them to the world. I even created a band for myself called 
"dia|lo|gues" (with only two members: me and my Mac) to cater to that need. 
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So, if you want to know what kind of songs I write, want to listen to them, want 
to get updates on the songs, or just curious whether I am able to sell a single 
song on iTunes or not, you can visit my web site: dia|lo|gues @ 
supersubconscious (http://dialogues.supersubconscious.com/) or my newly 
created MySpace page (http://www.myspace.com/dialogues/). 

Wish me luck and leave a comment or two. 
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A. The 10,000 hours rule 
In his book "Outliers", Malcom Gladwell discusses the 10,000 hours rule. It's 
basically a book about how people should go through 10,000 hours of practicing 
before they can really do what they do. I wrote a short blurb about this topic on 
my personal blog, supersubconscious, check it out: The 10,000 hours rule 
(http://www.supersubconscious.com/uncategorized/the-10000-hours-rule/). 

Famous motivator Anthony Robbins also said that "Practice is the mother of all 
skills". 

Relate the two together with our topic here, let me say that don't be 
discouraged by your first result. You'll get better over time. 

B. Further learning 
I've said it before and I'll repeat it again here: This short walkthrough about 
GarageBand and song publishing is far from enough to satisfy your need. So, 
you need to broaden your knowledge by getting additional materials from any 
source that you can find. 

1. About GarageBand 

There are many sources to learn GarageBand that you can find out there - both 
paid and free, from printed books, eBooks to multimedia tutorials. 

Go out there and search for more materials. 

2. About Marketing Your Songs 

While there are tons of references to learning GarageBand, there are almost 
none (as far as I know) that discusses song marketing. 

But I stumbled into this one course called Online Music Marketing 
(http://www.simpleology.com/p/musicpromo/simplescienceof/) that discusses 
the very topic. The course is not free (US$97 with 60 days money back 
guarantee), but you could consider it as an investment for your future. If you 
want to earn your living from music, you should give this one a try. 
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C. Upgrading to Logic? 
Now if you are really serious, and I mean REALLY SERIOUS, about producing 
professional quality music, you should consider upgrading your GarageBand to 
Logic or at least Logic Express. 

The suite is expensive (hundreds of dollars - ouch!) and heavy (you might need 
a more powerful Mac), and maybe it only suits serious musicians. But it has all 
the advanced bells and whistles that you won't find in GarageBand. 

 

D. The Real Coda 
To end this rather-long rambling, let me say what I always say: If you have 
thoughts, opinions, ideas, more resources, anything at all to share to other 
readers or to improve this book; leave comments on the MakeUseOf site or drop 
me a line. 

Thank you for reading (and sharing)! 
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Visit MakeUseOf.com for daily posts on cool websites, free software and internet tips. If 

you enjoyed this guide/manual then subscribe to MakeUseOf.com (via feed or email) and 

get instant access to several other such guides and cheat sheets to your favorite 

programs. 

- makeuseof.com(latest articles) 

- makeuseof.com/dir/(browse cool websites by category) 

- makeuseof.com/most-popular/(most popular articles) 

- feedproxy.google.com/Makeuseof(feed) 

- feedburner.google.com/fb/a/mailverify?uri=Makeuseof&loc=en_US (subscribe via mail) 

Don’t miss out on our other cool manuals! 

Subscribe via email or RSS to download! 
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